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Question: 

How do I center my site horizontally in the browser window? If I do this, how can I also get the height of my 
content to be 100% of the window?  How do I create styles to redefine my html and body tags? 

Answer: 
The answers to these questions are all related.  You must nest all the images, text, and even other 
Dreamweaver layers inside of a “container” layer or <div>.  In this HTML example, the “container” layer also 
holds the “logonav” and the “navbar” layers: 

 <div id="container"> 
  <div id="logonav">l 
  </div> 
  <div id="navbar"> 
  </div> 

</div> 
 
In the corresponding CSS, the html and body tags must be redefined to let the container use the available 
space of the browser window.  This layer must be also positioned “relative” to the page, and all other layers 
inside of it must positioned as “absolute”. See the comments in the code below: 
html { 
 width: 100%; /* redefining <html> to span the height and width of the browser window */ 
 height: 100%; 
 margin: 0px; 
 padding: 0px; 
} 
body { 
 width: 100%;  /* redefining <body> to span the height and width of <html> */ 
 height: 100%; 
 margin: 0px; 
 padding: 0px; 
} 
#container { 
 z-index: 1; 
 position: relative; /* container must be relative */ 
 margin: 0 auto; /* this centers the container horizontally within <body> */ 
 left: 0px; 
 top: 35px; 
 width: 700px; /* 700 pixels wide centered horizontally */ 
 height: 100%; /* 100% of the <body> tag */ 
} 
#logonav { 
 z-index: 2; 
 position: absolute; /* layers inside of “container” must be absolute */ 
 visibility: visible; 
 left: 0px; 
 top: 0px; 
 width: 300px; 
 height: 20px; 
} 
#navbar { 
 z-index: 3; 
 position: absolute; /* layers inside of “container” must be absolute */ 
 visibility: visible; 
 right: 0px; 
 top: 0px; 
 width: 500px; 
 height: 20px; 
} 



Question: 
How do I get rid of the underlines for links and change link colors?   

Answer: 
Link styles can be changed with CSS.  The easiest way is to use the Modify>Page Properties command. In 
the resulting window, select the Links category on the left side and then choose fonts, and colors, and 
underline preferences for all of the four states; Link, Visited, Hover, Active.  Dreamweaver will generate 
CSS code in between your <style> </style> tags that you can then edit, modify and later export to an 
external style sheet if you d like.  Notice the example below that the order of these states have to appear in 
this order (L,V,H,A) or the code won t work properly: 
a:link { 
 text-decoration: none; /* no underline here */ 
} 
a:visited { 
 text-decoration: underline; 
 color: #CC0000; 
} 
a:hover { 
 text-decoration: underline; 
 color: #33FF00; 
} 
a:active { 
 text-decoration: underline; 
 color: #FFFFFF; 
} 
 
 

Question: 
How can I create different link styles in different layers on the same page? 

Answer: 
In the examples above, different kinds of links are contained inside of their own layers such as “logonav” or 
“navbar”.  Also, link styles have been created using the standard a:link CSS rules.  Now just combine the 
two techniques into a rule that will first call the layer first and then any links that are inside of it. You ll need 
to have one set for each layer that you need to have different link styles: 
# logonav a:link { 
 color: #CC0000; 
} 
# logonav a:visited { 
 color: #660000; 
} 
# logonav a:hover { 
 color: #FF9900; 
} 
# logonav a:active { 
 color: #FFFFFF; 
} 
 
# logonav a:link { 
 color: #0000CC; 
} 
# logonav a:visited { 
 color: #000066; 
} 
# logonav a:hover { 
 color: #0099FF; 
} 
# logonav a:active { 
 color: #000000; 
} 
 



Question: 
I would like the navigation button to be a colored when someone is on the page so they know where they 
are.  I thought the a:active command controlled that, but it is not showing up colored.  What s the best way 
to handle this? When you say "assign a CSS style to indicate the current page", where do I add the style 
and what would it say? Is it put in the layer code itself, or in the html? 

Answer: 
The Active state is generally used only when your user clicks the button.  It appears only when the button is 
clicked and obviously disappears as soon as the user releases and a new page is loaded.  Here s a few 
ways to deal with this problem: 
A. The simplest way is to label each section apart from the buttons themselves as I've done on my site.   
B. You could also make separate templates for each section (not recommended) and change the proper 

button on each template.  This will require multiple template updates later however. 
C. This is the hardest, but most efficient way, and it will require some experimentation on your part.  You 

can assign a CSS style to a button layer indicating the current page. Exactly what style you decide to 
apply depends on how your buttons are made (for example images vs text, or individual layers vs 
loose links in a layer), but you basically need to assign a CSS class and apply it to the button.  This 
might come in the form of a border for an image or bold text for text links, but whatever you decide, this 
is the basic code structure: 

 <a href="page.html" class="selected">your link text here</a> 
 
  This anchor tag lists the class as “selected” calling up the following chained css rule: 
 a.selected:link {color: #cc6600;} 
 a.selected:visited {color: #cc6600;}  
 a.selected:hover {color: # cc6600;} 
  a.selected:active {color: # cc6600;} 

 
 

Question: 
Is there any way to change the spacing between paragraphs, lines of text, words and letters when working 
with body text? 

Answer: 
Yes. This CSS rule redefines the standard <p> tag that is commonly used in body text.  
See the comments in the code below: 
p { 
 margin-bottom: 5px; /* the space after each ending </p> tag */ 
 text-indent: 25px; /* the distance the first line of each <p> is indented */ 
 line-height: 15px; /* the height of lines of text contained within <p></p> tags */ 
 word-spacing: 1px; /* the space between words in <p></p> tags */ 
 letter-spacing: 12px/* the space between letteres in <p></p> tags */ 
} 

 
This can also be applied to other tags such as <h1> tags or even defined as a separate class (a style that 
can be applied to any text). 

 
 
Question: 

How can you apply transparency to layers? 
Answer: 

It is defined as Opacity in CSS.  Notice there are three parameters.  They should all be there to cover all the 
major browsers.  Leave one out and people on some browers may not see it correctly: 
#transbox { 

 width: 300px; /* standard layer commands from here to the background-color line */ 
 height: 200px; 
 background-color: #fff; 
 filter:alpha(opacity=50); /* 3 transparency commands notice whole numbers vs decimals */ 
 opacity: 0.5; 
 -moz-opacity:0.5; 

} 
 
 



Questions: 
 These are general questions related to the process of using templates and CSS. 
 

1. When I look at the CSS Style panel, I see that I have a ton of CSS styles already. Is it better to create 
your external CSS files before you set up your templates?  

2. Does each style or layer created in the template give you an internal CSS style? How do I handle them? 
3. After I ve built all my templates, how do I get the styles out the <head> of my templates and into that 

external file?  
4. How exactly do you "tell" your other templates or files to refer to the external style sheet (main.css)? 
5. Can text styles and layers go externally? And can I have more than one external style sheet file in one 

template? 
 

Answer: 
This is a multi-part answer that also outlines one good procedure for using templates and CSS with DW8. 
 
1. When you create a template and create layers and styles, it is normal that your CSS Styles panel will fill 

up with internal styles.  In the panel each style and layer is listed underneath the <style> tag, meaning 
that they exist in the <head> of your current template.  You should work this way until you ve tested the 
template and all of its child pages and everything works perfectly.  This way all your styles will be listed 
in one place at the beginning. 

 
2. You should keep an eye on your code as you create to be sure that styling elements do appear in as 

css commands.  It can be very sticky later on if some things are coming from CSS and others with 
HTML.  In your CSS, it is very important that all layers and styles have descriptive names and not the 
generic #Layer1, or .style1 names that DW assigns by default.  To change layer names, use the Layers 
panel in DW and double-click the layer to be renamed.  Change the names of .styles by right-clicking 
one in the CSS Styles panel and selecting “Rename” from the resulting popup menu.  You should also 
delete any unused or redundant styles in the same way as well as deleting unused layers in the Layers 
panel.  This is the best way to make changes since DW will change the names of any styles or layers in 
the CSS and HTML. 

 
3. Now you re ready to create an external style sheet from the embedded css in your template.  Use the 

File>Export>CSS Styles command to save a file to your web folder that will have all the currently used 
css styles in a separate (main.css) file.  Open the file to be sure your CSS code is there.  If it is, then go 
to your code view in the template and select everything to do with CSS in the head, starting with the  
<style type="text/css"> tag and ending with </style>, and delete. Don t worry if you re template has 
temporarily lost its style. We will re-apply it in the next step. 
 

4. All the information that has to do with layer behaviors and styles has been saved in the main.css file 
and the template will begin to work normally again as soon as you attach that file to the template.  In 
your CSS Styles panel (which should now be empty), click the chain button “Attach Style Sheet”.  In the 
resulting window, click the Browse button and locate the main.css file. Be sure that the option to Add 
as:Link is chosen since you want the CSS code to be external and coming from the main.css file. Your 
page should return to normal and the CSS Styles panel will show that each rule is listed under main.css 
instead of <style>.  If you look at your code in the <head> of your template, you ll see that DW has 
called up the file using the following code: 
<link href="main.css" rel="stylesheet" type="text/css" /> 

 
5. Other templates that will use the same layers and/or styles can call up the same sheet by deleting their 

embedded CSS code as we did in Step 3, and then linking to the sheet as in Step 4.  You can add or 
modify styles in that sheet by typing straight into the file, copying and pasting to it, and using the DW 
CSS Styles panel.  Any way you feel comfortable is fine as long as you only have valid CSS code in 
there.  If you wanted to use more than one external css file per template, you can always add it by 
following step 4 for that sheet.  DW will add it to the CSS Styles panel and make another line of code: 
<link href="secondary.css" rel="stylesheet" type="text/css" /> 
Just be sure that you don t have repeating or conflicting CSS rules now that you have two sheets! 
 
 

 



Question: 
How do I upload my site to my web host with DW?  
How do I remove old or unneeded files from the remote server?  

Answer: 
Be sure you ve properly defined your site from the start and have your web hosting info (username, 
password, etc) handy.  You should return to the Define Sites window for your site and click the Remote Info 
category on the left column.  Change access from none to FTP, then fill out the form using the information 
provided to you by your web host.  Depending on your host, you may be able to leave your Host Directory 
blank, or you may or may not need to direct DW to the right folder within your account folder, usually titled: 
/public_html/ 
 
After filling out all the fields properly, click the Test button and if all goes well, DW should announce: 
“Dreamweaver connected to your Web server successfully” 
If not, then double-check your fields and settings until the message does come up.  Now click the OK button 
to leave the Define Sites window entirely.  You should then open your Files panel and click the 
Expand/Collapse button to see the 2-column view.  Remote files will be on the left and local files on the 
right.  To upload your site, copy your files from the right column to the left.  If you continue to work locally, 
you will need to save and upload your changed local files again later.  If a file already exists remotely then it 
will be replaced once you upload again. 
 
To delete files on the remote server, select file(s) on the left side that you d like to delete and right-click on 
it.  Choose Edit>Delete from the resulting popup menu.  Be sure to only delete remote items if you know 
exactly what they are, or if you ve placed them yourself.  There s no undo here, so be careful. 
 

 
Question: 

Can you have commas in file names? What s the best way to name and manage files if I want to stay neat 
and organized? 

Answer: 
You can use commas in the operating system, but for published html files, I would not recommend it.  So in 
short, no. Instead try using only numbers or letters along with the underscore (_) character as a spacer. 
Never use the space bar to create spaces in file names or folder names. 
 
To avoid any other unexpected problems, always be sure you ve defined your site properly so DW can help 
you keep track of files, links, etc.  Keep your file names relatively short and simple and always lower-case.  
If you are creating files in a series, keep the numbering system consistent and start with “zero-one” for 
example: 
gallery01.html 
gallery02.html 
gallery03.html 
 
You can also organize large sections of your site into sub-folders within your root folder.  For example, this 
gallery may grow large enough to need over 30 pages (gallery30.html) so you could place them all in one 
folder that would contain only this section of the site (the gallery files).  The obvious name for the folder 
would be clear: 
gallery 
… Unless you had multiple galleries: 
gallery_photo 
gallery_draw 
gallery_misc 
 
 
 
 
 
 
 
 

 



Question: 
How do I use the mailTo JavaScript file to protect my email address from spammers? 

Answer: 
The JavaScript file has embedded instructions on how to activate it, if you open it in DW.  Clearly you would 
want to copy the file to somewhere in your root folder (maybe even a “scripts” sub-folder). The directions are 
pretty clear for the most part except for step 1, which talks about the window.onload statement. 
There are two common ways to approach this: 
 
A. Add the onload statement to the body tag.  This is not recommended since this makes it difficult to use 

and maintain templates.  You may only need this script for your "contact" page, so if you changed the 
template, you'd be forced to call it up on  other pages of your site that don t need it.  Either that, or you d 
have to break the contact page from the template.  The code looks like this: 
<body onload="mailTo();"> 

 
B. Add the onload statement to the end of the script.  Works great,  it's simple, self-contained and doesn't 

touch your html code or templates.   Unfortunately it's only works well if you are only using one 
JavaScript file on that particular page.  Since this will be the case for most of you I would recommend 
this method.  Just add this line to the end of the script s code after all brackets and punctuation, at the 
very bottom: 
window.onload = mailTo; 

 
 
 
Question: 

How do I get my site onto the search engines such as Google.  What are some common tags I can use to 
prepare my site for search engines? 

Answer: 
To submit on google, visit this link: 
http://www.google.com/addurl/ 
 
To begin preparing your site for search engines, continue to build your sites as we ve been doing with 
searchable text, complying to css standards, and be sure to at least use these 3 tags in the <head> of your 
page: 
 
A. <title>your page title here</title> 

Apart from telling your users which site, and part of the site they re on, search engines will use the title 
as the clickable text in their list of hits when your site comes up.  This will be the first thing users see if 
they see your site listed. 
 

B. <meta name="DESCRIPTION" content="A short one or two sentence blurb here."> 
This is what appears right below the title in the search engine listing. 
 

C. <meta name="KEYWORDS" content="photography, art, digital, commercial, boston"> 
Keywords are used internally by search engines along with descriptions, titles, and even the page 
content, and other criteria across your site to help rank your site it when someone does a search. 

 
There are other similar tags that you can find and add along with these, but these are the basics.  Each 
search engine does it a little differently and most of the major ones don't charge you for this service. There 
is a whole science behind optimizing your website for search engines.  It's known as SEO or Search Engine 
Optimization and if you do a search, you will find tons of hits since it's ever evolving field, and it can be a 
very deep topic. 

 


